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Introduction
This guide explains how to install Cisco Telemetry Broker (at times referred to as CTB in
this document). It describes the Cisco Telemetry Broker components and how they are
placed within your network.

Cisco Telemetry Broker enables you to do the following:

l Install Cisco Telemetry Broker

l Update Cisco Telemetry Broker

l Configure destinations and connections

l Migrate from Secure Network Analytics UDP Director

l Check the unreachability of a destination

l Use IPv4 or IPv6 destinations

l Pass through NIC for 10 Gbps throughput

l Use high availability

Audience
This guide is designed for the person responsible for maintaining network telemetry flow
and monitoring network telemetry.

Installing Physical Broker Nodes
If you want to install physical broker nodes, follow the instructions in the Cisco Telemetry
Broker Hardware Appliance Installation and Configuration Guide.

Common Abbreviations
The following abbreviations appear in this guide:

Abbreviation Description

DNS Domain Name Server/Service

Gbps Gigabits per second

GB Gigabyte

HTTPS Hypertext Transfer Protocol (Secure)
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Abbreviation Description

NAT Network Address Translation

NIC Network Interface Card

NTP Network Time Protocol

SSH Secure Shell

UDPD UDP Director

URL Universal Resource Locator

VLAN Virtual Local Area Network

VM Virtual Machine
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Concepts and Architecture
Cisco Telemetry Broker allows you to ingest network telemetry from many inputs,
transform the telemetry format, and forward that telemetry to one or multiple destinations.
Refer to the following table for examples.

Currently, the only hardware appliance that exists for Cisco Telemetry Broker is a
broker node (TB2300). This must be paired with a VMManager node for
deployment.

You can deploy a combination of both virtual and physical broker nodes, or you
can deploy only all virtual broker nodes or only all physical broker nodes.

There is no required order of installation for broker nodes, even if you are
deploying a combination of virtual and physical broker nodes.

You can ingest any of the following
telemetry:

And forward that telemetry to any or all
of the following destinations:

l On-premises network telemetry,
including NetFlow, syslog, and IPFIX

l Cloud-based telemetry inputs, such
as Amazon Web Services (AWS)
Virtual Private Cloud (VPC) Flow
Logs

l Analytics platforms, such as Secure
Network Analytics or Secure Cloud
Analytics

l Network management and
automation platforms, such as Cisco
DNA Center

l Security Information and Event
Management (SIEM) platforms

To accomplish this, you deploy one or more Cisco Telemetry Broker nodes, which ingest
telemetry and forward it to the configured destinations.

Out of the box, Cisco Telemetry Broker supports the following transformations:

Ingested Data Format Forwarded Data Format

VPC Flow Logs IPFIX

Microsoft Network Security Group IPFIX
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(NSG) Flow Logs

IPFIX, NetFlow v5, NetFlow v9 JSON (only to SCA destinations)

Your broker nodes are all managed by one Cisco Telemetry Broker Manager. You can log
in to this Manager's web interface and perform various configuration tasks, including
managing the broker nodes, setting up the forwarding connections, creating users, and
reviewing the dashboard for usage.

You deploy these broker nodes and Manager as virtual appliances on a hypervisor.
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Deployment Requirements
The following lists the prerequisites and recommendations for deploying Cisco Telemetry
Broker to your network to forward telemetry from a given input to a destination.

Browser Requirements
Cisco Telemetry Broker supports the following browsers (as tested with the latest rapid
release and with resolution at 1024 x 768 px):

l Google Chrome

l Microsoft Edge

l Mozilla Firefox

Broker Node Upgrade
For IPv6 systems only:When you upgrade to v2.1.3, you might see that the broker node
update process has not finished. If you check your certificate details in your Cisco
Telemetry Broker system, you will see that the Subject name is [<ipv6_address>].

Complete the following steps as a workaround:

1. Generate a new certificate without the surrounding brackets and upload the new
certificate.

2. On the broker node shell, run ctb-manage and choose Option c (re-fetch the
manager's certificate but keep all other information).

The broker node status will show that the process has finished.

l You cannot register a broker node older than v2.1.3 to a manager node
that is v2.1.3 or newer.

l You cannot register a v2.1.3 or newer broker node with a manager node
older than v2.1.3

Network Requirements
You must do the following before deployment:

l Download two OVA files and create a minimum of two virtual machines.

l Reserve one IP address for the Manager node and two IP addresses for each broker
node you deploy.
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Networks
Management Network: Every node (Manager or broker) in your deployment must have
one network interface (IPv4 or IPv6) connected to the Management Network to provide
for administration over SSH and HTTPS (if the node is running the management
functions).

Telemetry Network: The broker node must have a second interface (IPv4 or IPv6) that
must be connected to the Telemetry Network. On this network the node will receive
telemetry from inputs and forward it to destinations.

The Management Network and the Telemetry Network can be the same network.

Management Network Connection Configuration
Before installing Cisco Telemetry Broker, determine the following settings for the
Management Network:

l IPv4 or IPv6 address

l IPv4 or IPv6 subnet prefix length

l IPv4 or IPv6 default gateway address

l IPv4 or IPv6 DNS nameserver

You can configure the interface to be active on both an IPv4 and IPv6 address
simultaneously.

Telemetry Network Connection Configuration
Before installing Cisco Telemetry Broker, determine the following settings for the
Telemetry Network:

l IPv4 or IPv6 address

l IPv4 or IPv6 subnet prefix length

l IPv4 or IPv6 default gateway address

You can configure the interface to be active on both an IPv4 and IPv6 address
simultaneously.

Virtual Machine Requirements

For KVM deployments, telemetry brokering uses only 2 CPUs on the broker
node. Assigning additional CPUs improves the performance only if the broker
node is performing telemetry transformation.
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Hardware Configuration
You can deploy a broker node using any one of the following three different performance
profiles, depending on the performance type you want to achieve:

l 1 Gbit/s Use this profile to achieve line-rate packet brokering for a 1 Gbit/s NIC.
l 10 Gbit/s Use this profile to achieve line-rate packet brokering for a 10 Gbit/s NIC.
l Transformation Capable Use this profile to achieve telemetry transformation (for
example, sending IPFIX to Secure Cloud Analytics).

Configuration Manager Broker

CPU 4

1 Gbit/s: 2

10 Gbit/s: 5

Transformation Capable: 8

Memory 8GB

1 GBit/s: 12 GB

10 GBit/s: 12 GB

Transformation Capable: 12
GB

Storage 80GB 70 GB

The broker uses CPUs according to the information described in the following table. Use
this table as a reference to understand how different CPU allocations help to achieve the
desired performance type.

CPUs 1 Gbit/s 10 Gbit/s Transformation Capable

1 Degraded Degraded Degraded

2 Supported Degraded Degraded

3 Supported Degraded Degraded

4 Supported Degraded Degraded

5 Supported Supported Degraded
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6 Supported Supported Degraded

7 Supported Supported Degraded

8 Supported Supported Supported

VMWare ESXi

Resource Manager Broker

Network Interface #1 Connection to
Management Network

e1000e e1000e

Network Interface #2 Connection to
Telemetry Network

Not installed vmxnext

We recommend that you use the OVA defaults for all other values. To deploy ctb v1.4+
(which supports the IOMMU feature), ESXi needs to be v6.7+.

KVM QEMU

Resource Manager Broker

Disk virtio-scsi virtio-scsi

Network Interface #1 Connection to
Management Network

virtio virtio

Network Interface #2 Connection to
Telemetry Network

Not installed virtio

Time Synchronization
The Cisco Telemetry Broker VM synchronizes its system time with the hypervisor. To
ensure that features like TLS work correctly, hypervisor time needs to be accurate.

VMWare ESXi
To learn how to run NTP on the ESXi hypervisor, refer to this VMWare knowledge base
article.
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KVM QEMU
To ensure that the hypervisor and the guest are synced, confirm that you have defined the
track='guest' attribute for the guest machine 's XML configuration as shown in the
following image. For more information, refer to libvirt documentation.

This will synchronize the guest clock to the host clock value. However, you need to
accurately maintain the hypervisor host clock. To accomplish this, you can use an NTP
daemon.

By default, Cisco Telemetry Broker VM images are configured to run 1 CPU per socket.
For example, in the image below, CPU Topology shows 1 CPU core per socket on 5
CPU sockets for the total number of 5 CPUs allocated to the VM.
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If you have an issue regarding a clock skew in your VMs, we recommend that you change
the CPU topology to run all CPUs on 1 socket.

Open Communication Ports
The following table provides details for all the network connections made to and from
your Cisco Telemetry Broker appliances. To ensure that your network permits these
connections, you need to modify the applicable access controls you currently have in
place (for example, your firewall).

Client Server Port Description

users
broker nodes
and Manager
node

22/TCP SSH access to the console

Manager external internet 443/TCP
HTTPS for secure external
communications, such as Smart
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Licensing and Software Update

Manager
customer syslog
server

customer-
defined port

Syslog telemetry for Cisco
Telemetry Broker notifications

Manager
customer
SMTP server

customer-
defined port

SMTP telemetry for Cisco
Telemetry Broker notifications

each broker
node

Manager 443/TCP
HTTPS for secure management
connections

each broker
node

external internet 443/TCP

HTTPS for retrieving VPC/NSG
Flow Logs from AWS S3/Azure
SAS storage buckets,
respectively.

HTTPS for broker node to secure
access SCA server and upload
files to SCA S3 bucket.

users Manager 443/TCP
HTTPS for secure web interface
access

broker
nodes and
Manager
node

customer
DNS servers

53/UDP DNS telemetry

In addition, you must open ports based on both the telemetry type that is sent to a broker
node and the telemetry type that a broker node sends to a destination. The following table
provides details about common ports for various telemetry types:

Port Description

514/UDP syslog

2055/UDP NetFlow v5, NetFlow v9

4739/UDP IPFIX

6343/UDP sFlow
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Migrate Configuration to a New System
Complete the following processes to back up and restore the CTB connection
configurations that you set up in the Cisco Telemetry Broker Manager.

l It is possible for UDPD customers to migrate their existing UDPD configuration to
Cisco Telemetry Broker. For more details, see the "Importing and Exporting
UDP Director Configuration" section in the Cisco Telemetry Broker User Guide.

Back Up CTB Configuration Connections
Run the following command on the CTB Manager Node:

$ sudo ctb-backup-config -v -f ctb_config.json

When this process has finished, the connection configurations will be backed up to the
file at ~/.ctb_config.json, after which you can copy the connection configurations to
another location.

l VPC/NSG Flow Log connections are not backed up, so you need to re-create your
VPC/NSG Flow Log connections upon migrating to a new system.

l You can back up and restore your CTB connection configurations only within the
same version. If you try to do so across versions, the process may fail.

Restore the CTB Configuration Connections

You must run ctb-restore-config after you complete ctb-install --init
on the Manager node. If you manually create a GUI login account, it will be
overwritten by the account information from ctb-restore-config.

Complete these steps:

1. Log out as the install user.

2. Copy the ctb-config.json file from an existing system.

3. Log in to the new system as admin.

4. Run the following command on the CTB Manager Node:

$ sudo ctb-restore-config -v -f ctb_config.json

Any inputs that you add to Cisco Telemetry Broker due to the restore are not
assigned to any nodes or clusters. You will need to assign them as required.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. - 17 -

Migrate Configuration to a New System



Determine Network Configuration
Cisco Telemetry Broker supports multi-node setups, where a single Cisco Telemetry
Broker Manager can manage multiple broker nodes. Since Cisco Telemetry Broker
updates every broker node with all destinations and connections, you must carefully plan
your configuration to avoid a few common issues, which are listed below.

l You can deploy broker nodes in different telemetry segments, where the telemetry
interfaces of each broker node may not be accessible across the network. You need
to carefully construct connections so that packets from an exporter that reach a
specific node are not forwarded to destinations that are not accessible from that
node. To achieve this, you need to construct connections that exclude exporters
that might cause this routing issue. One example would be to not use any default
connections, since these would match all inputs.

l Not all destinations may be relevant to each broker node. However, with the Check
Destination Reachability feature, since each broker node attempts to ascertain
accessibility for each destination, the broker nodes could report conflicting
information back to the Manager. If the possibility exists that some broker nodes will
not be able to connect with some destinations, disable Check Destination
Reachability for those destinations.

If you are migrating to Cisco Telemetry Broker from the UDP Director, then before you
deploy the Manager node and the broker node OVA files, you need to plan how you will
connect the two VMs to the network, as differences exist between how you configure
both Cisco Telemetry Broker and the UDP Director.

Cisco Telemetry Broker differentiates telemetry traffic from management traffic. The
broker node has two interfaces: The Telemetry Network interface and the Management
Network interface. The Manager node has only the Management Network interface. The
following diagram shows how to logically deploy the Manager node and the broker
nodes.

Note that the examples in this topic represent typical deployment scenarios. To
learn how to set up a more advanced deployment (for example, one that uses
VLANs), contact a network administrator.
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Cisco Telemetry Broker receives management traffic only on the Management Network
interface; it uses this interface for all communications between the broker node and the
Manager node. Telemetry traffic is brokered primarily on the Telemetry Network interface
of the broker node. The only exception to this is when Cisco Telemetry Broker retrieves
AWS VPC Flow Logs or Azure NSG Flow L ogs, or when Cisco Telemetry Broker sends
telemetry to SCA, both of which occur over the broker node's Management Network
interface.

You can place the Manager node anywhere in the network on any subnet, but you must
have TCP connectivity over port 443 with the broker nodes.

You can use one of the following deployment modes with the broker node:

1. The telemetry subnets and management subnets are the same. In this mode, the
Telemetry Network interface and the Management Network interface on the broker
node belong to the same subnet. See Interfaces Belong to the Same Subnet.

2. The telemetry subnets and management subnets are different, so the broker node
retains its Telemetry Network interface and Management Network interface on two
separate subnets. See Interfaces Belong to Different Subnets.

Providing separate paths for both telemetry traffic and management traffic offers the
following advantages:

l Separate paths increases performance, especially when it approaches interface line
rate performance, since traffic doesn't need to share resources (such as virtual
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switches and physical NICs).

l Separating management traffic from telemetry traffic simply makes good sense for
a network configuration.

Interfaces Belong to the Same Subnet
This deployment mode is very similar to that of the UDP Director, where the management
interface and the Telemetry interface are the same. The only difference in this first
deployment mode is that you need separate IP addresses for the broker node interfaces.

Refer to the following images to see how to configure this type of deployment.

In a virtual environment, you can accomplish this in one of the following two ways:

1. You connect the broker node's Telemetry Network interface and Management
Network interface to the same virtual switch in the hypervisor.

2. You connect the broker node's Telemetry Network interface and Management
Network interface to different virtual switches, but you connect the underlying NICs
to the same physical switch and thus the same subnet.

Interfaces Belong to Different Subnets
In this deployment mode, the Telemetry Network interface and the Management Network
interface are on different subnets. In this case you typically need separate virtual switches
for the two interfaces.

Refer to the following image to see how to configure this type of deployment.
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Deploy Cisco Telemetry Broker
The following describes the high-level steps for deploying broker nodes to your network
and configuring them to ingest telemetry from inputs and export telemetry to destinations: 

l Deploy a Manager node and one or more broker nodes to your hypervisor
l Configure Cisco Telemetry Broker Smart Licensing
l Configure the Manager node to manage your broker nodes
l Configure one or more connections to control how broker nodes ingest and export
telemetry

l Review the state of your deployment performance from the dashboard

Note that the broker node continuously polls the telemetry interface NIC for incoming
telemetry, resulting in high CPU utilization. It is normal to see high CPU utilization of the
broker node.

Technical Limitations
l A single Cisco Telemetry Broker deployment supports a maximum of 10
destinations per input and 10 broker nodes per Manager node.

l If you disable exporters tracking, each broker node supports a maximum of 100k
exporters. If you enable exporters tracking for one or more inputs, we recommend
that you do not track more than 1000 exporters (totaled across all inputs), as this
may result in degraded performance.

(For information about disabling and enabling exporters tracking, see the "UDP
Inputs" topic in the Cisco Telemetry Broker User Guide.)

l A destination supports a maximum of 1000 subnets (totaled across all connections
for that destination). Adding more than 1000 subnets may result in data loss.
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VMWare Setup
We have tested the following instructions on VMWare ESXi 6.7.

You need to install and configure the Manager Node before you install the broker
node(s).

VMWare: Install the Manager Node
Complete the following steps in order:

1. Download the Manager Node OVA file.

2. Deploy the Manager Node.

3. Configure Resource Reservations.

4. Verify VM Time Settings.

5. Log in as the install user.

6. Run the sudo ctb-install --init command.

7. Configure the first super user account.

8. Log out.

You need to install and configure the Manager Node before you install the broker
node(s).

1. Download the Manager Node OVA File

1. Download the Manager Node OVA file.

2. On software.cisco.com, check the SHA512sum value of the OVA file.

3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

sha512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.
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2. Deploy the Manager Node

1. Log in to the VMWare vSphere web user interface console.

2. From the side menu, right-click Virtual Machine and then choose Create/Register
VM.

3. Choose Deploy a virtual machine from an OVF or OVA file.
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4. Enter the name of the OVA file.
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5. Configure the settings as shown in the following image.

6. Click Finish. The system will start and prompt you to log in.
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3. Configure Resource Reservations

Make sure you reserve virtual machine resources recommended per the
Deployment Requirements. Otherwise, the actual allocated resources could
be less than the recommended value, and you might receive one or both of the
following alerts:

l Insufficient CPU Allocated
l Insufficient Memory Allocated

The Manager node requires that all computer resources are dedicated to the VM. To
ensure this occurs, complete the following steps:

1. In the VMware interface, click the Manager node VM that you deployed in the
previous section, Deploy the Manager Node.

2. Click Edit to open the window in which you will edit the VM's settings.

3. Choose Virtual Hardware > CPU > Reservations.

4. To determine the Reservations value, multiply the number of CPUs on the VM by the
GHz value of your hypervisor's processor type (which you can find on the
Hypervisors Summary > CPU > Processor Type screen).
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l For example, if your hypervisor lists the processor type as@2.40 GHz, and
your VM is allocated 8 CPUs, then you would use this formula: 8 x 2.40 GHz =
19200 MHz. In this case, you should specify 19200 MHz as the Reservation
value.

l Some VMware products (for example, VCenter) provide a drop-down list that
includes a value labeled asMaximum that reflects the pre-calculated value
for you.

5. Choose Virtual Hardware > Memory > Reservations.

6. Check the Reserve all guest memory (all locked) check box.

7. Click Save to save these settings.

4. Verify VM Time Settings
The VM relies on the hypervisor to provide accurate time, and the default settings should
ensure this is occurring. However, we recommend that you verify this by completing the
following steps:

1. In the VMware interface, click the Manager node VM that you deployed in the
previous section, Deploy the Manager Node.

2. Click Edit to open the window in which you will edit the VM's settings.

3. Choose VM Options > VMware Tools > Time.

4. Ensure the Synchronize guest time with host check box is checked.

5. Click Save to save these settings.

5. Log In as the Install User
From the Manager node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).
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6. Run the sudo ctb-install --init Command

If you plan on restoring config from a different CTB deployment, then you must
run ctb-restore-config after completing ctb-install --init and logging
out as the install user. For more information, seeMigrate Configuration to a
New System.

1. Run the sudo ctb-install --init command.

2. Enter the following information:

l Password for the admin user

The password must meet the following requirements:
o Contain at least 8 characters
o Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ # $ % ̂  & * ! + ?
o Cannot be a commonly-used phrase or sequence
o Cannot be similar to any identifying attributes of the user (such as the
username)

l Hostname (max 255 characters, letters and numbers only)

l You can enter one or both of the following IP address parameters:
o IPv4 address, subnet prefix length, and default gateway address for the
Management Network interface

o IPv6 address, subnet prefix length, and default gateway address for the
Management Network interface

l Valid DNS nameserver IP address that is reachable from the virtual machine
(you can enter one or two)

To change any individual parameters in the future, run the sudo ctb-install
--config command.

7. Configure the First Super User Account
If this is the first time you are logging in to the Manager web interface, you must first
create the first Super user account before you install any broker nodes. We suggest
assigning the user name ofwebadmin so as not to confuse it with the admin user.
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l In a web browser, navigate to the following site to create it: https://<manager_ip_
address>.

8. Logout

To log out, type exit.

VMWare: Install the Broker Node
Complete the following steps in order:

1. Download the Broker Node OVA file.

2. Deploy the Broker Node.

3. Configure Resource Reservations.

4. Verify VM Time Settings.

5. Log in as the install user.

6. Run the sudo ctb-install --init command.

7. Run the sudo ctb-manage command.

8. Log out.

9. Configure the Telemetry Interface.

You need to install and configure the Manager Node before you install the broker
node(s).

1. Download the Broker Node OVA File

1. Download the Broker Node OVA file.

2. On software.cisco.com, check the SHA512sum value of the OVA file.

3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

sha512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.
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2. Deploy the Broker Node

1. Log in to the VMWare vSphere web user interface console.

2. From the side menu, right-click Virtual Machine and then choose Create/Register
VM.

3. Choose Deploy a virtual machine from an OVF or OVA file.
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4. Enter the name of the OVA file you downloaded in Step 3.
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5. Set the Default type to 1 Gbps, 10 Gbps, or Transformation Capable as appropriate
for your installation. Configure the remaining settings as shown in the following
image.

6. Click Finish.
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3. Configure Resource Reservations

Make sure you reserve virtual machine resources recommended per the
Deployment Requirements. Otherwise, the actual allocated resources could
be less than the recommended value, and you might receive one or both of the
following alerts:

l Insufficient CPU Allocated
l Insufficient Memory Allocated

The broker node requires that all computer resources are dedicated to the VM. To ensure
this occurs, complete the following steps:

1. In the VMware interface, click the broker node VM that you deployed in the previous
section, Deploy the Broker Node.

2. Click Edit to open the window in which you will edit the VM's settings.

3. Choose Virtual Hardware > CPU > Reservations.

4. To determine the Reservations value, multiply the number of CPUs on the VM by the
GHz value of your hypervisor's processor type (which you can find on the
Hypervisors Summary > CPU > Processor Type screen).
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l For example, if your hypervisor lists the processor type as@2.40 GHz, and
your VM is allocated 8 CPUs, then you would use this formula: 8 x 2.40 GHz =
19200 MHz. In this case, you should specify 19200 MHz as the Reservation
value.

l Some VMware products (for example, VCenter) provide a drop-down list that
includes a value labeled asMaximum that reflects the pre-calculated value
for you.

5. Choose Virtual Hardware > Memory > Reservations.

6. Check the Reserve all guest memory (all locked) check box.

7. Click Save to save these settings.

4. Verify VM Time Settings
The VM relies on the hypervisor to provide accurate time, and the default settings should
ensure this is occurring. However, we recommend that you verify this by completing the
following steps:

1. In the VMware interface, click the broker node VM that you deployed in Section 2,
Deploy the Broker Node.

2. Click Edit to open the window in which you will edit the VM's settings.

3. Choose VM Options > VMware Tools > Time.

4. Ensure the Synchronize guest time with host check box is checked.

5. Click Save to save these settings.

5. Log In as the Install User
From the broker node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).
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6. Run the sudo ctb-install --init Command

1. Run the sudo ctb-install --init command.

2. Enter the following information:

l Password for the admin user

The password must meet the following requirements:
o Contain at least 8 characters
o Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ # $ % ̂  & * ! + ?
o Cannot be a commonly-used phrase or sequence
o Cannot be similar to any identifying attributes of the user (such as the
username)

l Hostname (max 255 characters, letters and numbers only)

l You can enter one or both of the following IP address parameters:
o IPv4 address, subnet prefix length, and default gateway address for the
Management Network interface

o IPv6 address, subnet prefix length, and default gateway address for the
Management Network interface

l Valid DNS nameserver IP address that is reachable from the virtual machine
(you can enter one or two)

To change any individual parameters in the future, run the sudo ctb-install
--config command.

7. Run the sudo ctb-manage Command

1. Run the sudo ctb-manage command.

2. Enter the following information:

l IP address of the Manager node

l Username of the super user account you create in the Manager node

l Password of the super user account you create in the Manager node
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8. Logout

To log out, type exit.

9. Configure the Telemetry Interface
Go to Configure the Telemetry Interface.

When you remove a broker node from the Manager, you need to deactivate the
node to prevent telemetry from continuing to be sent through the assigned
inputs. To do this, run the ctb-manage command, then choose option d to
deactivate the node.
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KVM Setup
The following instructions for setting up your KVM (Kernel[based] Virtual Machine) are
based on the following:

l libvirt 7.1.0

l qemu-kvm 5.2.0

l Linux Kernel 5.10.26

l Virtual Machine Manager (virt-manager) Ubuntu 2.2.1

Before you proceed, confirm in your Virtual Machine Manager that you have
chosen the Enable XML Editing option. If your version of Virtual Machine
Manager does not support XML editing, you can perform the same step using the
virsh edit command on your KVM host.

1. Open the VM Manager and choose Edit > Preferences.

2. Check the Enable XML Editing check box and click Close.
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KVM: Install the Manager Node
Complete the following steps in order:

1. Download the Manager Node QCOW2 file.

2. Launch the virtual machine.

3. Log in as the install user.

4. Run the sudo ctb-install --init command.

5. Configure the first super user account.

6. Log out.

You need to install and configure the Manager Node before you install the broker
node(s).

1. Download the Manager Node QCOW2 File

1. Download the Manager Node QCOW2 file.

2. On software.cisco.com, check the SHA512sum value of the QCOW2 file.

3. After the QCOW2 file is downloaded, verify that the SHA512sum value of the
QCOW2 file matches the SHA512 Checksum value on software.cisco.com. To do
this, run the following command:

sha512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.
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2. Launch the Virtual Machine

1. Open the Virtual Machine Manager on your Linux system running KVM and click
Create a new virtual machine.

2. In Step 1 of the Create a new virtual machine dialog, check the Import existing
disk image option. Click Forward.
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3. In Step 2 of the Create a new virtual machine dialog, do the following:

a. Enter the existing storage path to your QCOW2 file that you downloaded in
Step 1.

b. For the operating system, choose Debian Buster.

c. Click Forward.

Make sure you reserve virtual machine resources recommended per the
Deployment Requirements. Otherwise, the actual allocated resources could
be less than the recommended value, and you might receive one or both of the
following alerts:

l Insufficient CPU Allocated
l Insufficient Memory Allocated

4. In Step 3 of the Create a new virtual machine dialog, do the following:

a. In the Memory (RAM) field, set the entry to at least 8 GB.

b. In the CPUs field, set the entry to at least 4.

c. Click Forward.
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5. In Step 4 of the Create a new virtual machine dialog, do the following:

a. In the Name field, enter ctb-manager.

b. Check the Customize configuration before install check box.

c. Click Finish.

6. Do the following:

a. From the side menu, choose Overview.

b. Click the XML tab.
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c. Change the line <timer name="rtc" tickpolicy="catchup"/> to
<timer name="rtc" tickpolicy="catchup" track="guest"/>

d. Click Apply.

7. Do the following:

a. From the side menu, choose VirtIO Disk 1.

b. On the Details tab, under Advanced Options, choose SCSI from the Disk bus
drop-down list.

c. Click Apply.
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8. Click Begin Installation in the top left corner of the page.

3. Log In as the Install User
From the Manager node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).
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4. Run the sudo ctb-install --init Command

If you plan on restoring config from a different CTB deployment, then you must
run ctb-restore-config after completing ctb-install --init and logging
out as the install user. For more information, seeMigrate Configuration to a
New System.

1. Run the sudo ctb-install --init command.

2. Enter the following information:

l Password for the admin user

The password must meet the following requirements:
o Contain at least 8 characters
o Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ # $ % ̂  & * ! + ?
o Cannot be a commonly-used phrase or sequence
o Cannot be similar to any identifying attributes of the user (such as the
username)

l Hostname (max 255 characters, letters and numbers only)

l Specify the interface names if they are different from the default
names: default mgmt = 'ens160' and default telem = 'ens192.'

l You can enter one or both of the following IP address parameters:
o IPv4 address, subnet prefix length, and default gateway address for the
Management Network interface
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o IPv6 address, subnet prefix length, and default gateway address for the
Management Network interface

l Valid DNS nameserver IP address that is reachable from the virtual machine (you
can enter one or two)

To change any individual parameters in the future, run the sudo ctb-install
--config command.

5. Configure the First Super User Account
If this is the first time you are logging in to the Manager web interface, you must first
create the first Super user account before you install any broker nodes. We suggest
assigning the user name ofwebadmin so as not to confuse it with the admin user.

l In a web browser, navigate to the following site to create it: https://<manager_ip_
address>.

6. Logout

To log out, type exit.

KVM: Install the Broker Node
Complete the following steps in order:

1. Download the Broker Node QCOW2 file.

2. Launch the virtual machine.

3. Log in as the install user.

4. Run the sudo ctb-install --init command.

5. Run the sudo ctb-manage command.

6. Log out.

7. Configure the Telemetry Interface.

You need to install and configure the Manager Node before you install the broker
node(s).

1. Download the Broker Node QCOW2 File

1. Download the Broker Node QCOW2 file.

2. On software.cisco.com, check the SHA512sum value of the QCOW2 file.
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3. After the OVA file is downloaded, verify that the SHA512sum value of the OVA file
matches the SHA512 Checksum value on software.cisco.com. To do this, run the
following command:

sha512sum <path/to/file>

On software.cisco.com, you can view the SHA512sum value by hovering your
cursor over the tooltip for the link.

2. Launch the Virtual Machine

1. Open the Virtual Machine Manager on your Linux system running KVM and click
Create a new virtual machine.

2. In Step 1 of the Create a new virtual machine dialog, check the Import existing
disk image option. Click Forward.
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3. In Step 2 of the Create a new virtual machine dialog, do the following:

a. Enter the existing storage path to your QCOW2 file that you downloaded in
Step 1.

b. For the operating system, choose Debian Buster.

c. Click Forward.

Make sure you reserve virtual machine resources recommended per the
Deployment Requirements. Otherwise, the actual allocated resources could
be less than the recommended value, and you might receive one or both of the
following alerts:

l Insufficient CPU Allocated
l Insufficient Memory Allocated
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4. In Step 3 of the Create a new virtual machine dialog, do the following:

a. In the Memory (RAM) field, set the entry to at least 2 GB.

b. In the CPUs field, set the entry to 2 (assigning additional CPU to the broker
does not necessarily improve performance on KVM).

c. Click Forward.
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5. In Step 4 of the Create a new virtual machine dialog, do the following:

a. In the Name field, enter ctb-broker.

b. Check the Customize configuration before install check box.

c. Click Finish.

6. Do the following:

a. From the side menu, choose Overview.

b. Click the XML tab.

c. Change the line <timer name="rtc" tickpolicy="catchup"/> to
<timer name="rtc" tickpolicy="catchup" track="guest"/>

d. Click Apply.
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7. Do the following:

a. From the side menu, choose VirtIO Disk 1.

b. On the Details tab, under Advanced Options, choose SCSI from the Disk bus
drop-down list.

c. Click Apply.
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8. From the side menu, choose Add Hardware > Network. Click Finish.
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9. Click Begin Installation.

3. Log In as the Install User
From the broker node virtual machine within the vmware user interface, open a web
console and log in to the virtual machine (the username is install; there is no password).
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4. Run the sudo ctb-install --init Command

1. Run the sudo ctb-install --init command.

2. Enter the following information:

l Password for the admin user

The password must meet the following requirements:
o Contain at least 8 characters
o Contain at least 1 lowercase letter
o Contain at least 1 uppercase letter
o Contain at least 1 digit
o Contains at least 1 of these special characters: @ # $ % ̂  & * ! + ?
o Cannot be a commonly-used phrase or sequence
o Cannot be similar to any identifying attributes of the user (such as the
username)

l Hostname (max 255 characters, letters and numbers only)

l Specify the interface names if they are different from the default
names: default mgmt = 'ens160' and default telem = 'ens192.'

l You can enter one or both of the following IP address parameters:
o IPv4 address, subnet prefix length, and default gateway address for the
Management Network interface

o IPv6 address, subnet prefix length, and default gateway address for the
Management Network interface

l Valid DNS nameserver IP address that is reachable from the virtual machine
(you can enter one or two)

To change any individual parameters in the future, run the sudo ctb-install
--config command.
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5. Run the sudo ctb-manage Command

1. Run the sudo ctb-manage command.

2. Enter the following information:

l IP address of the Manager node

l Username of the super user account you create in the Manager node

l Password of the super user account you create in the Manager node

6. Logout

To log out, type exit.

7. Configure the Telemetry Interface
Go to Configure the Telemetry Interface.

When you remove a broker node from the Manager, you need to deactivate the
node to prevent telemetry from continuing to be sent through the assigned
inputs. To do this, run the ctb-manage command, then choose option d to
deactivate the node.
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Configure the Telemetry Interface
1. Log in to Cisco Telemetry Broker. In a web browser, enter the Manager's

management interface IP address and press Enter to navigate to the Manager's
web interface login.

2. From the main menu, choose Broker Nodes.

3. In the Broker Nodes table, click the applicable broker node.

4. In the Telemetry Interface section, click the (Edit) icon (indicated by the arrow in
the following image).

5. Configure the IP and Gateway addresses (enclosed in red border).
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Manage High Availability Clusters
Cisco Telemetry Broker high availability provides highly available IPv4 and IPv6 virtual
IP addresses to be targets for your inputs, ensuring reliable delivery of telemetry from
inputs to destinations.

To establish Broker Node high availability, you can create high availability clusters and
assign multiple broker nodes to each. In each cluster, one broker node is designated
Active, meaning it passes telemetry and serves metrics to Cisco Telemetry Broker, and
the rest are designated Passive, meaning they are not passing telemetry or serving
metrics currently. If an Active broker node stops passing telemetry or otherwise loses
connectivity with Telemetry Broker, one of the Passive broker nodes is promoted to
Active broker node and starts passing telemetry.

Note the following about clusters:

l Each broker node can only belong to one cluster at a time.
l You can create a cluster without assigning a broker node, but note that the cluster
will not receive telemetry until you add a node.

l You can assign an input to an empty cluster, but note that the cluster will not receive
telemetry until you add a node.

l When you remove a broker node from a cluster, that node no longer has any inputs
assigned to that cluster.

l Keep in mind that if you create a cluster with only one broker node and this broker
node fails, no other broker node is available to be promoted to Active broker node.
Similarly, if all broker nodes within a cluster fail, no broker node can be promoted to
Active broker node. If a broker node fails, bring it back online as soon as possible.

l You cannot choose which broker node is active in a given cluster.
l If an Active broker node for a virtual IP address fails, one of the Passive broker
nodes in the same cluster becomes the Active broker node for the virtual IP
address. When the failed broker node comes back up again, it remains a Passive
broker node. If you want to make that node active again, you will need to do so
manually using the provided commands in the Move a VIP to a Specific Node
section in this chapter.

l You can assign either a virtual IPv4 or virtual IPv6 address, or both, to a cluster.
Telemetry Broker uses this virtual IP address to communicate with the cluster and
promote Passive broker nodes to Active broker nodes when an Active broker node
loses connectivity with Telemetry Broker.
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For information about how HA clusters are updated during the Cisco Telemetry Broker
software update process, see the "Software Update" chapter in the Cisco Telemetry
Broker User Guide.

VIPs and Routing
High availability configures the VIP address broker node's Telemetry Network interface.
Note that the Telemetry Network interface on each broker node in the clustermust
already be configuredwith a primary IPv4 or IPv6 IP address, as well as with a subnet
prefix length and a gateway. You can configure these in the Telemetry Network interface.

You must configure the IPv4 or IPv6 VIP IP addresses to be in the same subnet as the
primary IP addresses of the Telemetry Network interfaces in the cluster, since the VIP
must be in the same subnet as well. This ensures proper routing via the preconfigured
Gateway and fast failover.

If the VIP addresses are not in the same subnet as the primary IP addresses of the
Telemetry Network interfaces, or if the Telemetry Network interfaces within a Cluster are
configured with different subnets, then it is very likely that high availability will not work.

Manage Clusters
The Cisco Telemetry Broker implementation relies on two commonly used Linux
packages to provide the underlying high availability infrastructure:

Corosync: This is the low-level cluster engine that provides the underlying
communication between cluster nodes. It also provides the quorum capability to make the
decision on the role of each node (Active or Standby).

Pacemaker: This is Cluster Resource Manager which manages all the relationships
between the machines and the applications. It uses Corosync to communicate.

View Current Cluster Status
To view the current status of the cluster, including the status (Offline or Online) of each
node and the location of the IPv4 VIP (vip4) and the IPv6 VIP (vip6) IP address, complete
the following steps:

1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Run the sudo crm_mon command. This presents a view of the currently configured
attributes on the cluster. You can see more details about this command here.

3. Exit the tool by pressing Ctrl+C.
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The previous image describes a cluster of two nodes, 10.0.81.31 and 10.0.81.32, which
both have the status of Online. The IPv4 VIP (vip4) is currently running on 10.0.81.31. The
IPv6 VIP (vip6) is not visible because it has not been configured.

If 10.0.81.31 failed, its status would look like this:

Notice how 10.0.81.31 is now shown as OFFLINE and the vip4 has moved to 10.0.81.32.

View Current Cluster Configuration
To view the current configuration of the cluster to verify that the Corosync and Pacemaker
configuration is correct, complete the following steps:

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. - 59 -

Manage High Availability Clusters



1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Run the sudo crm configure show command. This presents a view of the
currently configured attribute on the cluster. You can see more details about this
command here.

Enable and Disable Node Standby Mode
In Standby mode, the node cannot host the IPv4 or IPv6 virtual IP addresses.

1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Run the sudo crm node standby 10.0.81.32 command. You can omit the
node name if you are running this command on that node. You can see more details
about this command here.

3. Run the sudo crm node online 10.0.81.32 command to move the node out of
Standby status. You can see more details about the command here.

© 2024 Cisco Systems, Inc. and/or its affiliates. All rights reserved. - 60 -

Manage High Availability Clusters

https://crmsh.github.io/man-2.0/#cmdhelp_configure_show
https://crmsh.github.io/man-2.0/#cmdhelp_node_standby
https://crmsh.github.io/man-2.0/#cmdhelp_node_online


As you can see, crm_mon displays the standby status of the 10.0.81.32 node.

Move a VIP to a Specific Node
You may encounter circumstances in which you want to specify which node is running the
IPv4 or IPv6 virtual IP address. If so, complete the following steps:

1. Log in as the admin to any of the broker nodes in the cluster from the console into
the virtual machine provided by VMWare vCenter, or via SSH. Use the password
that was supplied during node installation.

2. Run the sudo crm resource move vip4 10.0.81.32 command. You can see
more details about this command here.

3. Run the sudo crm resource unmove vip4 command to make sure the VIP stays
on the targeted node, otherwise the VIP will move back to the node it was
previously on (before the move) at the next opportunity.
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Configure Your Virtual Machine to use a
Physical NIC
We have pre-configured the ctb-node OVA file with a Telemetry Network interface using
the vmxnet3 virtual driver. The vmxnet3 driver should work fine for workloads up to
approximately 1Gbps, but it will begin to lag for workloads that exceed approximately 1
Gbps.

To support full 10Gbps telemetry, you need to configure your VM to use a physical NIC,
which in VMWare is called VMDirectPath I/O passthrough. The Configuring VMDirect I/O
pass-through knowledgebase article explains how to configure a physical NIC as a pass-
through device.

After you set up the ESXi server with a passthrough device, complete the following to add
it to the ctb-node VM:

1. After you import the OVA file, shut down the VM.

2. In the vSphere Client, right-click the virtual machine and click Edit Settings.

a. Click Add New Device.

b. Choose PCI Device.

c. Choose the pci pass-through device you configured.

d. To update the VMmemory settings, check the Reserve all guest memory
(All locked) check box.

e. Click OK.

3. Start the VM and run through the install process as described above. After you enter
your password you will be prompted to choose theManagement Network
interface and Telemetry Network interface from a list of three different NICs.

a. Use the 82574L Gigabit Network Connection NIC as the Management
Network interface.

b. Use the pass-through NIC as the Telemetry Network interface (the
description will most likely say (10Gbps).

Your virtual machine is now running with a pass-through interface.
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Enable a Flow Generator Input on a Broker
Node (Optional)
Starting with v2.1.3, you can enable a Flow Generator input on a broker node.

System Requirements for a Flow Generator Input Capable
Broker Node
Cisco Telemetry Broker has configured the OVA file with the following three options:

l 1 Gbps

l 10 Gbps

l Transformation-Capable

Chosen
Configuration CPU Memory Storage

1 Gbps 3 12 GB 70 GB

10 Gbps 9  16 GB 70 GB

Transformation 12 16 GB 70 GB

If the number of CPUs or memory does not comply with the requirements shown in the
previous table, the broker node will still work, but with degraded performance.

After you import the OVA file, you can add more CPUs, memory, and a network interface
to make the node capable of receiving raw network traffic from the monitoring interface
and to generate IPFIX records. This optional functionality is provided by the Flow
Generator Plugin on the broker node. The IPFIX records can then be forwarded by the
broker node from the Flow Generator input to configured destinations. If you wish to
enable Flow Generator functionality, depending on which hypervisor you are using,
complete the following steps in the applicable section.

The following instructions assume that the broker's telemetry interface has
already been configured as specified in Configure the Telemetry Interface.

VMWare ESXi
1. Shut down the VM.
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It is mandatory that you shut down the VM, even if you just want to add a network
device.

2. In the vSphere Client, right-click the virtual machine and click Edit Settings.

3. Do one of the following:

l Add 1 CPU for a 1 Gbps deployment

l Add 4 CPUs for a 10 Gbps deployment or for a Transformation deployment

4. Do one of the following:

l Add 4G memory for a 1 Gbps deployment

l Add 8G memory for a 10 Gbps deployment or for a Transformation
deployment

5. Click Add Network Adapter and add the network device you will use as a Flow
Generator monitoring interface.

6. From the Adapter drop-down list, choose the virtual switch port group you want this
adapter to connect to.

7. From the Adapter Type drop-down list, choose VMXNET 3. For example, see the
following screenshot.
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8. Click Save.

9. Start the VM.

KVM
1. Shut down the VM.

It is mandatory that you shut down the VM, even if you just want to add a network
device.

2. In the Virtual Machine Manager, from the main menu, click View > Details.
3. From the left pane, click CPUs.

4. Do one of the following:

l Add 1 CPU for a 1 Gbps deployment

l Add 4 CPUs for a 10 Gbps deployment or for a Transformation deployment

5. Do one of the following:

l Add 4G memory for a 1 Gbps deployment

l Add 8G memory for a 10 Gbps deployment or for a Transformation
deployment

6. In the lower left corner, click Add Hardware.

7. From the left pane, click Network.

8. To choose the subnet you want to monitor, do the following:

l On the details tab, choose a network source from the Network drop-down list

l Choose the applicable option from the Portgroup drop-down list

9. From the Device model drop-down list, choose virtio.

10. Click Finish.

11. Start the VM.

Configure Monitoring Interface and Flow Generator Input
After completing the previous hypervisor specific resource steps, you now need to do the
following:

l Configure the monitoring interface from which to ingest the raw network traffic.
l Assign the Flow Generator input to the broker node.
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To enable Flow Generator functionality on the broker node, both the monitoring
interface and Flow Generator input must be configured, and you should also
assign Flow Generator input to the broker node. The order of configuration
should not matter, but we suggest to start with configuring the monitoring
interface, as documented in the steps below.

1. Start the broker node virtual machine.

2. From the command line of the broker node, run sudo ctb-install --config.
3. ClickMonitoring Interface.

4. Choose the network adapter you added in VMWare to add it to the virtual machine
interface and set the MTU.
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5. Click OK.

6. In the Cisco Telemetry Broker Manager Web UI, click the Broker Nodes tab.

7. In the list of broker nodes, click the applicable broker node.

8. Click the Monitoring Interface tab and verify that the monitoring interface you
configured in Step 3 is correct.

9. Click the Inputs tab.

10. Click Add Input.

11. From the Select input type drop-down list, choose Flow Generator Input.

12. Click Next.
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13. In the Input Name field, enter the input name.

14. Adjust other Flow Generator input parameters if the default values don't fit your
deployment.

15. Click Add Input.

To see the parameter description, hover over the tooltip (the "i" icon) next to the
parameter name.
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16. From the Assigned Broker Node drop-down list, assign the input you configured in
the previous step to the appropriate broker node.

17. Click Assign Nodes.

The Flow Generator microservice, provided by the vpp-fs container on the broker node,
should now be running.

18. Verify this with the sudo docker ps command issued in the broker node terminal.

19. Connect the Flow Generator input to the previously configured destination. This can
be either a UDP destination (for example, Cisco SNA Flow Collector), or an XDR/
SCA cloud destination. Just like with other input types, you can forward Flow
Generator input traffic to multiple destinations. You can do this from the Data Flow
page by clicking the plus sign (+) on the right side of the configured Flow Generator
Input card and dragging it to the applicable Destination card.

20. Click Save.
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21. Repeat Step 16 for all configured destinations.

At this point, your broker node will generate the metadata in the form of IPFIX records.
These records contain information about the raw network traffic observed on the
monitoring interface. The broker node forwards the records to configured destinations
with or without transformation, depending on the destination type.
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Disable Flow Generator Functionality

1. Do one of the following:

l Unassign Flow Generator input from the broker node.

l From the Monitoring Interface submenu of the terminal interface, set the
monitoring interface to None.

2. Run sudo ctb-install --config.

3. From the Monitoring Interface submenu, use the Down Arrow key to select None.

4. Click OK.
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Enable Your Telemetry Broker License
Cisco Smart Licensing is a flexible licensing model that provides you with an easier,
faster, and more consistent way to purchase and manage software across the Cisco
portfolio and across your organization. And it's secure — you control what users can
access. With Smart Licensing you get:

l Easy Activation: Smart Licensing establishes a pool of software licenses that can
be used across the entire organization—no more PAKS (Product Activation Keys).

l Unified Management: My Cisco Entitlements (MCE) provides a complete view into
all of your Cisco products and services in an easy-to-use portal, so you always
know what you have and what you are using.

l License Flexibility: Your software is not node-locked to your hardware, so you can
easily use and transfer licenses as needed.

To use Smart Licensing, you must first set up a Smart Account on Cisco Software Central
(software.cisco.com). For a more detailed overview about Cisco Licensing, go to
cisco.com/go/licensingguide.

Assistance
For assistance with your Cisco Smart Account and Smart Licensing, please contact us
through either of the following resources: 

l Go to Support Case Manager at https://mycase.cloudapps.cisco.com/case and
choose Software Licensing > Security Related Licensing as a case type.

l Call your TAC world-wide support number at
https://www.cisco.com/c/en/us/support/web/tsd-cisco-worldwide-contacts.html
and open a licensing request.

Licensing Overview
After you deploy the Manager, perform the following actions:

1. Create the initial super user account.

2. Create a Cisco Smart Account.

3. Open Smart Licensing in Telemetry Broker.

4. Review Evaluation Mode Status.

5. Register Your Product Instance.
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If your Cisco Telemetry Broker does not have direct access to your Cisco Smart Account
and will communicate through a Smart Software Manager On-Prem (also known as
Transport Gateway), select Transport Gateway for your Transport Settings.

Cisco Telemetry Broker requires Smart Software Manager On-Prem v8-202010
or higher.

Review the following On-Prem guide to complete the installation and configuration.

l Smart Software On-Prem:

https://www.cisco.com/c/en/us/support/cloud-systems-management/smart-
software-manager-satellite/tsd-products-support-series-home.html

1. Create the Initial Super User Account
When you use Cisco Telemetry Broker in Evaluation mode, you can use it for 90 days.
Evaluation mode is based on active usage of Cisco Telemetry Broker. For example, if you
shut down Cisco Telemetry Broker, the countdown resumes when it is turned on again.

To use Cisco Telemetry Broker with maximum default functionality, and to add licenses
and features to your account, register your product instance with your Smart Software
Manager in Smart Licensing.

Make sure you register your product instance before the 90-day evaluation
period expires. When the evaluation period expires, Cisco Telemetry Broker
stops receiving telemetry from inputs and sending telemetry to destinations. To
resume functionality, register your product instance.

1. In a web browser, enter the Manager's management interface IP address and press
Enter to navigate to the Manager's web interface login.

2. Enter your first and last names, email address, user name (we suggest assigning the
user name ofwebadmin so as not to confuse it with the admin user), and
password, and click Create to create the initial super user account.

2. Create a Cisco Smart Account
With a Cisco Smart Account, you can view your software, services, and devices in one
portal (also known as Cisco Smart Software Manager).

To use Smart Licensing with Cisco Telemetry Broker, you must have a Cisco Smart
Account. With a Cisco Smart Account, you can view your software, services, and devices
in one portal (also known as Cisco Smart Software Manager).
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For licensing Cisco Telemetry Broker, you will use your Smart Account to register your
product instance, manage licenses, run reports, and configure notifications. For more
information, refer to Smart Licensing on cisco.com.

l Tutorials: For video tutorials, refer to Smart Licensing Resources.
l Instructions: For detailed instructions about using your Cisco Smart Account, log in
to your Cisco Smart Account. Click Help or use the online assistant.

3. Open Smart Software Licensing in Telemetry Broker
1. Log in to Cisco Telemetry Broker.

2. Click the (Global Settings) icon in the toolbar in the upper right corner of any
page and choose Settings.

3. Click the Smart Licensing tab.

4. Review Evaluation Mode Status
1. Open Smart Licensing in Cisco Telemetry Broker.

2. Click the Global Settings icon in the toolbar in the upper right corner of any page
and choose Settings.

3. Click the Smart Licensing tab.
4. In the Smart Software Licensing Status section, review Registration Status and

License Authorization Status.

Status Details

Registration Status Unregistered

Your product instance is not
registered to a Cisco Smart
Account. Register your product
instance before the evaluation
period expires.

When the evaluation period
expires, Cisco Telemetry Broker
stops receiving telemetry from
inputs and sending telemetry to
destinations. To resume
functionality, register your product
instance.
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License Authorization Status

No Licenses in
Use

After you have launched a Cisco
Telemetry Broker deployment and it
has started processing telemetry, it
takes 24 hours for Cisco Telemetry
Broker to calculate and report
entitlement usage.

Evaluation Mode

Your product instance is using
Evaluation mode and the number of
days remaining is shown. To see
more detailed information, hover
your pointer over the status.

5. Register Your Product Instance
To use Smart Licensing with Cisco Telemetry Broker, you must have a Cisco Smart
Account. With a Cisco Smart Account, you can view your software, services, and devices
in one portal (also known as Cisco Smart Software Manager).

For licensing Cisco Telemetry Broker, you will use your Smart Account to register your
product instance, manage licenses, run reports, and configure notifications. For more
information, refer to Smart Licensing on cisco.com.

l Tutorials: For video tutorials, refer to Smart Licensing Resources.
l Instructions: For detailed instructions about using your Cisco Smart Account, log in
to your Cisco Smart Account. Click Help or use the online assistant.

Use the following instructions in the order of the following steps to register your product
instance before the evaluation period expires.

a. Log in to your Cisco Smart Software Manager.

b. Configure transport settings.

c. Create the registration token.

d. Register in Telemetry Broker.

e. (As Needed) Change product instance registration.

Make sure you register your product instance before the 90-day evaluation
period expires. When the evaluation period expires, Cisco Telemetry Broker
stops receiving telemetry from inputs and sending telemetry to destinations. To
resume functionality, register your product instance.
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a. Log in to Your Cisco Smart Software Manager
To use Cisco Telemetry Broker with maximum default functionality, and to access
purchased licenses and features on your account, log in to your Cisco Smart Account and
register your product instance with your Smart Software Manager in Smart Licensing.

1. Go to Cisco Software Central at https://software.cisco.com.

2. Click the (User) icon.

3. Log in with your CCOID credentials.

l Log In: If you have an account, click Log In.
l Create an Account: If you do not have an account, click Create an Account.
Follow the on-screen prompts to set up your account.

4. In the License section, choose Smart Software Licensing.

b. Configure Transport Settings
Configure how Cisco Telemetry Broker communicates with your Cisco Smart Account
(Cisco Smart Software Manager). If you change the configuration here, those changes will
apply to Smart Call Home and other features using this service.

1. Log in to Cisco Telemetry Broker.

2. Click the Smart Licensing tab.
3. In the Smart Software Licensing Status section, locate Transport Settings.
4. Click View/Edit.

If the product instance is already registered, deregister it before you change the
transport settings. Refer to Deregister for details.

5. Select a transport setting.

Transport Settings Description

Direct

Use this option if your Cisco Telemetry Broker has
direct access to your Cisco Smart Account and it is
not blocked by a firewall. Cisco Telemetry Broker
lists the URL that Cisco Telemetry Broker will
attempt to directly access.
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Transport Gateway

If Cisco Telemetry Broker does not have direct
access to your Cisco Smart Account and will
communicate through Transport Gateway or Smart
Software Manager On-Prem, choose Transport
Gateway.

In the URL field, enter the location of the Smart
Software Manager On-Prem that contains the
licenses for your product instance.

For Example:
https://<SSM-ON-PREM-URL>SmartTransport

HTTPS Proxy

This option is available only if you've configured
Cisco Telemetry Broker to use a proxy. If so, you
can choose the HTTPS Proxy option to tell Cisco
Telemetry Broker to use the proxy for
communicating with the Cisco Smart Licensing
server. To configure the proxy, refer to the next
section, c. Configure the Internet Proxy, for
instructions.

6. Select Save.

c. Configure the Internet Proxy
To enable the HTTPS Proxy option for your Cisco Telemetry Broker Transport Settings,
make sure your Internet Proxy is configured.

1. Log in to Cisco Telemetry Broker.

2. Click the Global Settings icon in the toolbar in the upper right corner of any page.
3. Click the Use HTTPS proxy Toggle icon to enable HTTPS proxy functionality (the

icon bar will turn blue).

4. In the IP Address field, enter the proxy server IP address.
5. In the Port field, enter the port number Cisco Telemetry Broker uses to

communicate with the proxy server.

6. Click Save.

d. Create the Registration Token

1. Log in to your Cisco Smart Account at https://software.cisco.com.

2. In the License section, choose Smart Software Licensing.
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3. Select Inventory.
4. In the Product Instance Registration Tokens section, click New Token.
5. Complete the fields in the Create Registration Token dialog box to identify the token

on your account and specify how it can be used.

6. Click Create Token.
7. Locate your token in the Product Instance Registration Tokens list.

8. Copy the Token: Click the token name and copy it, or choose one of the following:

l Copy: To copy the token, click Actions > Copy
l Download: To download the token as a text file, click Actions > Download.

e. Register in Cisco Telemetry Broker

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Click Register.

3. Paste the token as plain text or type it into the Product Instance Registration Token
window.

4. Click Register.

If the communication times out during registration, review your transport
settings.

5. Review the Smart Software Licensing Status section and confirm:

l Registration Status: Registered
l License Authorization Status: Authorized
l Out of Compliance: If the status is shown as Out of Compliance, you may
need to add licenses to your account. Refer to Troubleshoot Licensing for
more information.

6. Review the Smart License Usage section. Confirm all licenses are shown as
Authorized.

l Status Details: Open Smart Licensing in Cisco Telemetry Broker and review
Smart License usage to determine which licenses are out of compliance.

l Out of Compliance: If any licenses are shown as Out of Compliance, you may
need to add licenses to your account. Refer to Troubleshoot Licensing for
more information.
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f. (As Needed) Change Product Instance Registration
Use the following instructions to change or update your product instance registration with
your Smart Software Manager in Smart Licensing.

Deregister
Use the following instructions to remove your product instance from your Cisco Smart
Account. If you deregister your product instance, note the following:

l Virtual Account Inventory: The licenses it was using are returned to the virtual
account, and other product instances in your account can use those licenses.

l Evaluation Mode: Your product instance will return to Evaluation mode if there are
days remaining in your evaluation period.

Use deregister before you change your transport settings or for troubleshooting.

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Click Actions.
3. Select Deregister.

Reregister
If your product instance was disconnected or Cisco Telemetry Broker could not connect
with the Cisco Smart Account after repeated attempts, the License Authorization Status
shows Registration Expired. Use the following instructions to resolve any communication
issues and reregister the product instance.

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Check your Transport Settings and review your Cisco Smart Account to confirm
communications.

If you need to change your transport settings, deregister your product instance
first.

3. Click Actions > Reregister.
4. Log in to your Cisco Smart Account at https://software.cisco.com.

5. In the License section, choose Smart Software Licensing.
6. Select Inventory.
7. In the Product Instance Registration Tokens section, click New Token, or locate

your token in the Product Instance Registration Tokens list.
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8. Copy the token and paste it into the Product Instance Registration Token window in
Cisco Telemetry Broker.

9. Click Reregister.
10. Review your Smart Software Licensing Status to confirm:

l Registration Status: Registered
l License Authorization Status: Authorized

Review Status and Usage
When you register your product instance with your Smart Software Manager in Smart
Licensing, the Cisco Telemetry Broker Smart Licensing page shows your Cisco Smart
Account and product instance details, including the following: 

Product Instance Details

Information Details

Registration Status Refer to Registration Status for details.

License Authorization Status Refer to License Authorization Status for details.

Export Control Functionality
Refer to the online help in your Cisco Smart
Account.

Smart Account
Refer to the online help in your Cisco Smart
Account.

Virtual Account
Refer to the online help in your Cisco Smart
Account.

Product Instance Name

The Product Instance Name is the identifier we use
for your Cisco Telemetry Broker product instance,
which includes your Cisco Telemetry Broker
Manager Node and broker nodes. Use your product
instance name to identify your product instance in
your Cisco Smart Account.

Transport Settings
Refer to Step 2 in the "Register Your Product
Instance'" section in Enable Your Telemetry
Broker License for details.
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Registration Status
Cisco Telemetry Broker connects to your Cisco Smart Account and reports the licensing
status and usage.

1. Open Smart Licensing in Telemetry Broker.

2. Review the Smart Software Licensing Status section.

Status Details

Registered

Your product instance is registered and reporting
license usage to your Cisco Smart Account. To see
renewal and expiration details, hover your pointer
over the status.

Unregistered

Your product instance is not registered to a Cisco
Smart Account. Register your product instance
before the evaluation period expires.

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker License for details.
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License Authorization Status

Status Details

Authorization Expired

If Cisco Telemetry Broker loses communication
with your Cisco Smart Account, your authorization
may expire.

Authorization Expired indicates the communication
status. It is does not indicate license status. To
review license status (purchased, expired, and
usage), review your Cisco Smart Account.

Authorized

Your product instance is registered and your
licenses are authorized.

To see authorization attempts and details, hover
your pointer over the status.

Evaluation Period Expired

Your evaluation period has expired and telemetry
processing has stopped. To see more detailed
information, hover your pointer over the status.

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker License for details.

Evaluation Mode

Your product instance is using Evaluation mode and
the number of days remaining is shown. To see
more detailed information, hover your pointer over
the status.

Refer to "Evaluation Mode (90 Days)" and "Register
your Product Instance" in Enable Your Telemetry
Broker Licensefor details.

Out of Compliance

If there is a license shortage for Cisco Telemetry
Broker, it is out of compliance.

Refer to "Resolve Out of Compliance"
inTroubleshoot Licensing for details.
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Review Smart License Usage
Cisco Telemetry Broker reports license usage to your Cisco Smart Account.

If your Smart License status shows Out of Compliance, this indicates that Cisco Telemetry
Broker has a license shortage and is using more licenses than are allocated in your Cisco
Smart Account. Refer to the "Resolve out of Compliance" section in Troubleshoot
Licensing

Troubleshoot Licensing
Use the following instructions to resolve any license-related errors shown in Smart
Licensing.

Resolve Out of Compliance
If the License Authorization Status or Smart License Usage shows Out of Compliance, an
appliance or feature has a license shortage and is using more licenses than are allocated
in your Cisco Smart Account.

Review your Licenses
Review the following:

l Open Smart Licensing in Cisco Telemetry Broker and review Smart License usage
to determine which licenses are out of compliance.

l Confirm you have sufficient licenses assigned to your virtual account. Refer to your
Cisco Smart Account for details.

l If you need to purchase additional licenses, please contact your account Manager
or the Cisco Telemetry Broker Sales team at stealthwatch-sales@cisco.com.

Update Cisco Telemetry Broker
After you add or move licenses to your virtual account, use the following instructions to
update the status in Telemetry Broker.

Renew Authorization Now
Cisco Telemetry Broker reports license usage to your Cisco Smart Account. Use Renew
Authorization Now to connect to your account and update your license usage telemetry
immediately. Use these instructions if you've changed the licenses on your Cisco Smart
Account, but they are not shown on your Smart Licensing page.

1. Open Smart Licensing in Cisco Telemetry Broker.

2. Click Actions > Renew Authorization Now.
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Renew Registration Now
If your product instance was disconnected or Cisco Telemetry Broker could not connect
with the Cisco Smart Account after repeated attempts, the License Authorization Status
shows Registration Expired. Use Renew Registration Now to connect to your account
and update your registration status.

1. Select the Actionsmenu.
2. Select Renew Registration Now.

Registration Expired: If the License Authorization Status continues to show
Registration Expired, you may need to reregister the product instance. Refer to
"Reregister" in Enable Your Telemetry Broker License for details.
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Review License Expiration Status
Your purchased licenses, allocations, expiration status, and usage are shown in your
Cisco Smart Account. For more information, refer to "Cisco Smart Account" in Enable
Your Telemetry Broker License.
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Troubleshoot Cisco Telemetry Broker
General: Since the appliance is running a stock Debian 10 operating system, you can
apply most general Linux system administration practices to troubleshooting.

Management Networking: The Management Network interface on the appliance is
managed through the systemd-networkd service rather than the ifup, ifdown or ifconfig
tools that you may be familiar with. After you have completed the installation of Cisco
Telemetry Broker, you can find configuration information in this file:

/etc/systemd/network/management.network

Telemetry Networking: The Manager Node manages the Telemetry Network interface on
the appliance. After installation, the Telemetry Network interface is mostly invisible to the
operating system. Therefore, you must make configurations using the Cisco Telemetry
Broker management layer.

Telemetry Packet Capture: Just as with configuration, you use a custom Cisco
Telemetry Broker tool to capture packets on the Telemetry Network interface instead of
operation system utilities. To do this, you must SSH to the appliance and run the following
command:

$ sudo ctb-pcap -V -n 1000 -t 15 -s 10.203.3.3 -o test_tx_src.pcap
rx

This command writes the captured output to /var/lib/titan/pcap/test_tx_src.pcap. You
can use the —help option to view all the available options.

Diagnostics: The appliance contains a diagnostic tool namedMayday that can capture
debug information for the Cisco Telemetry Broker engineering team. You should include
this helpful information to bug reports.

To create a diagnostic pack withMayday, simply SSH to the appliance and run the
following command:
sudo mayday

This will compile the relevant system information into a tar ball that can be copied off the
node to another location using the SCP tool. The location of the resulting tar ball will be
included in the Mayday logs.
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Example:

$ ssh admin@<ctb-node-ip>

ctb-node> sudo mayday

<output-redacted>

2020/08/05 19:04:45 Output saved in /tmp/mayday-ctb-5SWVTpSx-
202008051904.677025165.tar.gz

2020/08/05 19:04:45 All done!
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Finish Configuring Your System
To finish configuring your system, refer to the following sections in the Cisco Telemetry
Broker User Guide:

l Destinations

l Inputs

l Broker Nodes
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Appendix A: Using Adaptive Mode on a Broker
Node
By default, the Telemetry Network interface on the broker node is configured to operate in
Polling mode (where the system continuously polls for network traffic). This increases
CPU utilization even when there is low network traffic, but it provides high performance
under heavy network traffic.

In CTB v1.4 and later, you can place the Telemetry Network interface in Adaptive mode. In
this mode, at low bandwidth rates, the interface processes data as it becomes available;
it does not poll for data. At higher bandwidth rates the interface switches to Polling mode.
This reduces CPU utilization under low network loads.

We recommend that you use Adaptive mode ONLY if the broker node expects
non-bursty, low bandwidth UDP traffic (< 500K PPS). If this is not the case, then
do not enable Adaptive mode, as it could result in dropped packets.

In order to use Adaptive mode for a broker node, you need to manually enable IOMMU on
your broker node’s VM after you have completed the upgrade to v1.4. Enabling IOMMU
automatically puts the Telemetry Network interface in Adaptive mode.

For more information, see the "Software Update" chapter in the Cisco Telemetry Broker
User Guide.

Enable Adaptive Mode
This first step is common to both VMWare and KVM, so complete this step before you
progress to the appropriate section.

l Log in to the broker node shell and add this command:

set interface rx-mode eth1 adaptive

to this file:

/var/lib/titan/vppconfig/vpp_custom_cmds.txt

VMWare
IOMMU is supported on ESXi v6.7+. If you have ESXi v6.7+, complete the following steps
to upgrade VM compatibility and enable IOMMU.

You need to complete Step 1 through Step 5 only if you have upgraded from a
previous version to v1.4 (or any future released versions).
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1. Log in to the VMWare vSphere web user interface.

2. Shut down the VM for the broker node.

3. From the main menu, choose Actions > Upgrade VM Compatibility.

4. In the Configure VM Compatibility dialog, choose ESXi 6.7 virtual machine from the
drop-down list, and then click Upgrade.

5. In the Confirm VM Compatibility Upgrade dialog, click Yes.
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6. After the upgrade process has finished, to edit the VM's settings, click Edit from the
main menu.

7. In the Edit settings dialog, complete the following steps:

a. In the left panel, click the arrow for the CPU option.

b. Check the Expose IOMMU to the guest OS check box.

c. Click Save.

8. Verify that

l your VM's compatibility type is ESXi 6.7 virtual machine.
l the IOMMU option status is set to Enabled.
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9. Power on the VM.

10. Run the following command to check the mode:

docker exec -it titan-vpp vppctl show hardware eth1

11. Verify that all vpp_wk_x threads are in adaptive mode instead of polling mode.

Example:

KVM
To enable Adaptive mode in KVM, make the following configuration changes for the XML
domain using the Virtual Machine Manager user interface.

1. Open the Virtual Machine Manager on your Linux sytem that is running KVM.

2. Open the Broker Node virtual machine and click the (Information) icon to see the
virtual hardware details.
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3. Click the XML tab.

4. In the left panel, click Overview. Confirm IOAPIC is enabled.

5. Add the IOMMU device.
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6. In the left panel, click the NIC device that will be used as the Telemetry Network
interface. Confirm it has IOMMU and ATS enabled. We recommend that you
configure a queue size of 5.
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7. Run the following command to check the mode:

docker exec -it titan-vpp vppctl show hardware eth1

8. Verify that all vpp_wk_x threads are in adaptive mode instead of polling mode.

Example:
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Contact Support
If you need technical support, please do one of the following:

l Contact your local Cisco Telemetry Broker Partner
l Contact Cisco Telemetry Broker Support
l To open a case by web: http://www.cisco.com/c/en/us/support/index.html
l To open a case by email: tac@cisco.com
l For phone support: 1-800-553-2447 (U.S.)
l For worldwide support numbers:
https://www.cisco.com/c/en/us/support/web/tsd-cisco-worldwide-contacts.html
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TO LOCATE THE SOFTWARE LICENSE OR LIMITEDWARRANTY, CONTACT YOUR CISCO
REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program
developed by the University of California, Berkeley (UCB) as part of UCB's public domain
version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of
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NOTWITHSTANDING ANY OTHERWARRANTY HEREIN, ALL DOCUMENT FILES AND
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Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its
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